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Wireless WAN Guide
Keep this guide in a convenient place to access important 
information about your wireless product.

If you need assistance: 

❖ Toshiba’s Support Web site
pcsupport.toshiba.com

❖ Toshiba Global Support Centre
Calling within the United States (800) 457-7777
Calling from outside the United States (949) 859-4273 

Please fill in for your reference and future use:

Model name______________________________________

Part number______________________________________

Serial number____________________________________
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Safety Icons

This guide contains safety instructions that must be observed 
in order to avoid potential hazards that could result in 
personal injuries, damage to your equipment, or loss of data. 
These safety cautions have been classified according to the 
seriousness of the risk, and icons highlight these instructions 
as follows:

Indicates an imminently hazardous situation which, if not avoided, 
will result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, 
could result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury.

Indicates a potentially hazardous situation which, if not avoided, may 
result in property damage.

Provides important information.

Other icons used
Additional icons highlight other helpful or educational 
information: 

TECHNICAL NOTE: This icon highlights technical information about 
the computer.

HINT: This icon denotes helpful hints and tips.

DEFINITION: This icon indicates the definition of a term used in the 
text. 
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Introduction
Your Toshiba Notebook PC comes with an installed wireless 
WAN device and VZAccess Manager software preinstalled 
on your system. This gives you a high-speed connection to 
the Internet, corporate intranet, and your email while you're 
away from the office. This guide provides all the information 
you need to get started and use your new Toshiba 3G module 
module and VZAccess Manager software.

Safety Hazards 
Please read the Instruction for Safety and Comfort manual 
that shipped with your system. It contains important safety 
information. The User's Guide that is preinstalled on your 
system also contains important wireless information. 

Using your PC aboard an aircraft: 
Present aviation agency regulations and airline policies typically 
require that you turn off your PC and any wireless communication 
switches or devices before boarding an aircraft. 
While it is foreseeable that during certain non-critical phases of your 
flight, certain PC and/or wireless technologies might be permitted 
for use on board an aircraft, use of wireless WAN communication is 
normally prohibited. Since this PC is equipped with the wireless 
WAN feature, please be sure to turn off the wireless communication 
switch even if use of wireless LAN and/or Bluetooth is permitted. For 
this PC model, a single wireless switch controls all wireless commu-
nications and wireless LAN and/or Bluetooth cannot be selectively 
turned on without also turning on wireless WAN. If the wireless 
switch is turned on, wireless WAN radio waves may be transmitted. 
Unapproved use of PC and/or wireless communication might 
interfere with navigation and aircraft communication systems, 
possibly causing serious injury.

Limitation of Liability
While Toshiba has made every effort at the time of 
publication to ensure the accuracy of the information herein, 
product specifications, configurations, system component/
options availability are all subject to change without notice.
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Trademarks 
Verizon Wireless is a trademark of Verizon Trademark 
Services LLC, and the other trademarks, logos, and service 
marks (collectively the "Trademarks") used in this document 
are the property of Verizon Wireless or their respective 
owners. Nothing contained in this document should be 
construed as granting by implication, estoppel, or otherwise, 
a license or right of use of Verizon Wireless or any other 
Trademark displayed in this help file without the written 
permission of Verizon Wireless or its respective owner.
VZAccessSM is a service mark of Verizon Wireless
Microsoft®, MSN®, ActiveSync®, Outlook®, Outlook 
Express® and Windows® are either registered trademarks or 
trademarks of Microsoft® Corporation in the United States 
and/or other countries.
Netscape and the Netscape N and Ship's Wheel logos are 
registered trademarks of Netscape Communications 
Corporation in the U.S. and other countries.
AOL® is a registered trademark of America Online, Inc.
HotSync® is a registered trademark of Palm, Inc.
All other brand and product names are trademarks or 
registered trademarks of their respective companies.

Copyright
(c) 2006 Toshiba America Information Systems, Inc.

Patents and Licenses 
Licensed by QUALCOMM Incorporated under one or more 
of the following patents:
4,901,307 5,490,165 5,056,109 5,504,773 5,101,501
5,506,865 5,109,390 5,511,073 5,228,054 5,535,239
5,267,261 5,544,196 5,267,262 5,568,483 5,337,338
5,600,754 5,414,796 5,657,420 5,416,797 5,659,569
5,710,784 5,778,338
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Getting Started
This section will walk you through how to get started using 
your Toshiba 3G module. This includes using the VZAccess 
Manager software and setting up a data session to connect to 
the Internet.

This guide
This guide offers important information about your wireless 
WAN and VZAccess Manager software, including solutions 
to the most common problems, plus features and options.

Supported services
VZAccess Manager supports the following services from 
Verizon Wireless*:
❖ BroadbandAccess - Verizon Wireless BroadbandAccess 

is one of the fastest, fully mobile wireless Internet data 
solutions available. Quickly download complex files and 
view email attachments at broadband-like speeds 
(typically 300-500 Kbps, capable of reaching 2 Mbps). 
Visit www.verizonwireless.com/b2c/mobileoptions/
broadband/index.jsp for service availability and 
additional details. 

Present BroadbandAccess equipment devices also support 
NationalAccess.

❖ NationalAccess - NationalAccess delivers typical speeds 
of 60 to 80 Kbps, bursting up to 144 Kbps**. This 
service requires a subscription to a NationalAccess plan. 
Additional information is available at 
www.verizonwireless.com/b2c/mobileoptions/
nationalaccess/index.jsp..
* 3G Wireless use requires separately purchased subscription service from Verizon 

Wireless. Access limited to coverage area. See www.verizonwireless.com.

** Speed claim based on network tests using 101 Kilobyte FTP data files. Actual 
throughput speed and coverage may vary.

You do not need a separate Internet service provider (ISP) to access 
the Internet when using NationalAccess or BroadbandAccess.
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Using VZAccess Manager
Today's online world offers more services everyday and the 
Toshiba 3G module provides you with the tools you need to 
take advantage of the best in connectivity solutions. With 
VZAccess Manager, enjoy the freedom and convenience of 
wireless Internet connectivity from your Toshiba notebook 
computer.

Features
WWAN (Wireless Wide Area Network) specific features
❖ Creates a NationalAccess - BroadbandAccess 

connection. This connection will automatically attempt 
connecting via NationalAccess if the BroadbandAccess 
service is unavailable.

❖ Signal strengh for most wireless phones.
❖ Features a test function for your WWAN device. 
Other features
❖ Can launch your browser, email client, VPN or a program 

of your choice upon connection.
❖ Logs connections used, connection duration, and bytes 

sent and received.
❖ Supports TXT messaging.

Getting Started with VZAccess Manager
To launch VZAccess Manager:
❖ Double-click the VZAccess Manager icon on your 

desktop, or click the Windows® Start menu, then 
Programs, and then select VZAccess Manager.

The Networks view
By default, VZAccess Manager will open the Networks view, 
allowing you to manage your wireless connection. This view 
lists all currently available network connections and indicates 
their respective signal strengths. Normally, there will be one 
network shown in the Available Networks display, 
“NationalAccess-BroadbandAccess.”
Your 3G module is a BroadbandAccess capable device, so a 
NationalAccess-BroadbandAccess connection will 
automatically be created. This connection will use 
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BroadbandAccess, if available, and will automatically 
attempt a NationalAccess connection when 
BroadbandAccess is not available.
❖ If your expected connection does not display, select 

Refresh Networks from the Options menu. VZAccess 
Manager will look for your wireless device(s) and verify 
network availability. 

❖ To update the signal strength of your WWAN, select 
Refresh Signal Levels from the Options menu. 

❖ The status bar along the bottom of the window displays 
your current connection state and the elapsed time of any 
connection. 

(Sample Illustration) Network View

Connecting to the Internet
Once your WWAN device is properly configured, connecting 
to the Internet is as simple as selecting your network 
connection and clicking the Connect button. 
1 Select NationalAccess - BroadbandAccess as your 

network.
2 Click the Connect button.

To end your current session, click Disconnect. 
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The status bar
Information regarding your current network connection can 
be viewed in the status bar along the bottom of the VZAccess 
Manager main screen. 
VZAccess Manager will display status information at the 
bottom of the screen during the connection process and while 
your connection remains active.
❖ When not connected, the status in the lower left corner 

will display "Not connected," and the timer will display 
"00:00:00."

❖ When connected, the status will display "Connected" and 
the elapsed timer will begin to run. 

❖ When a connection is active, its name will appear as bold 
text.

This status is also reflected in the Task Tray icon. 

(Sample Illustration) Task Tray Icons

A window will also slide out of the tray showing when you 
connect and disconnect from networks.
This pop-up can be turned off, as desired, by selecting Tools, 
then Preferences, then clicking the Options tab, and then un-
checking Show popup status windows by tray. 
❖ Right-clicking on the tray icon provides additional 

options.
❖ Double-clicking on the tray icon displays the application.

Connected

Idle - Not Connected

Connecting

Disconnecting
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❖ Placing your cursor over the tray icon displays the 
current connection status.

Based on your preferences, your browser, email or VPN 
program can be automatically launched, or you can launch 
another software program (for example, a Microsoft® Office 
application). You can also specify if non-wireless accounts 
show in the drop-down list or only your wireless WAN 
network connections. For more information, refer to “Setting 
Your Preferences”.

Always use the VZAccess Manager when connecting via 
NationalAccess - BroadbandAcces. This will ensure that the wireless 
device is configured properly before connecting.

At any time during connection, you can check your current 
speed and throughput in the Statistics tab of the Session 
Information window. To display this window, select 
Statistics from the Options menu.

(Sample Illustration) Sessions Information Window

The Session Information window also contains a My 
Computer tab for accessing detailed information about your 
computer. This information is often helpful when 
troubleshooting a problem.
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Additional information about the NationalAccess connection
If you are using the NationalAccess - BroadbandAccess 
connection and the call fails when you try to connect, 
VZAccess Manager will return to its idle state. In this case, 
you should try to connect again. 
Dormant Data Sessions
NationalAccess - BroadbandAccess data sessions become 
dormant if you are not sending or receiving data. As soon as 
you resume sending or receiving data, the data session will 
return to an active state.
Depending on your device and your NationalAccess or 
BroadbandAccess plan, your data session may disconnect 
during a dormant state. If this occurs, select Disconnect, and 
then Connect again. Refer to your Verizon Calling Plan 
brochure for details or visit www.verizonwireless.com. 

TXT Messaging
VZAccess Manager supports TXT messaging.

(Sample Illustration) TXT Messaging View
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Receiving TXT messages
❖ All of your TXT messages appear in the list box at the 

top of the TXT messaging view. By default, both sent and 
received messages display.

❖ To filter your messages, click the View toolbar button 
and then select Received Messages, Sent Messages or 
All Messages.

❖ If you are in the TXT Messaging view and a new 
message arrives, the message will automatically appear 
in the list and be displayed in bold.

❖ To view a long TXT message, select the message in the 
list view. The details of the message will appear below 
the list.

❖ If you are not in the TXT Messaging view and a new 
message arrives, a TXT icon will appear in the status bar 
showing that new messages are available. There is also a 
TXT preference option that can automatically switch 
VZAccess to the TXT Messaging view when new 
messages arrive. By default, this feature is turned off.

❖ To reply to an inbound message, select the message and 
press the Reply toolbar button. The phone number of the 
sender will automatically be entered. Enter your new 
message and press the Send button to send the message.

❖ To forward an inbound message, select the message and 
press the Forward toolbar button. The message will be 
entered and prefixed with a "FW:". Press the Send button 
to send the message.

❖ To resend a message, select the message and press the 
Resend toolbar button. The phone number and message 
will automatically be entered. Press the Send button to 
resend the message.

Sending TXT messages
❖ To send a TXT message to an individual or to multiple 

Verizon Wireless messaging subscribers, simply enter a 
Verizon Wireless 10-digit mobile number or click on the 
To button to open your Contact List. Separate each 
mobile number with a comma, (Ex: 4529067334, 
6594556321).
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❖ To send a TXT message to one of the entries in your 
Contact List, click the To button to open the Contacts 
window.
Double-click the name of the user to add them to the 
Send To field.

To select multiple names from the list, hold down the Ctrl 
key while you click on the desired names.

❖ Enter the Phone Number and Message.
❖ The character counter counts all the characters typed in 

the message field (from 0 to 160).
❖ Click the Send button.
TXT contacts
The Address Book allows you to store the names and mobile 
numbers of your personal contacts.
To create a personal contact:
❖ From the Contact List dialog, press the Add button.
❖ Enter the name of the contact in the Name field.
❖ Enter the 10-digit mobile number into the Mobile 1 field.
❖ The Mobile 2 field can be used to enter a second mobile 

phone number. This is used if the individual sends you a 
message from this number. You will see the user's name 
next to the inbound message instead of the phone 
number.

❖ Click the OK button. The contact name displays in the 
list.

To edit a personal contact:
❖ Click a name in your contact list and press the Edit 

button.
❖ Make the necessary changes and then click the OK 

button.
❖ Clicking the Cancel button will not save any changes 

you have made.
❖ Clicking the Delete button will remove that name from 

your list.
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VZAccess Manager Preferences
Options tab
To display the Options tab, click on Tools, then Preferences, 
and then click the Options tab.

(Sample Illustration) Options Tab

The following options are available on the Options tab:
Minimize Application into tray: When selected, when you 
minimize VZAccess Manager, instead of taking up space on 
your desktop, it will disappear. To re-display it, double-click 
on the tray icon (alternatively, you can right-click on the icon 
and select Show Application). You can minimize the main 
VZAccess Manager window by selecting the minimize icon 
in the upper right corner of the main window.
Show popup status windows by tray: Enables a popup 
status notification above the task bar whenever a connection 
status changes.
Run VZAccess Manager at startup: Selecting this option 
adds VZAccess Manager to the Windows® startup group; 
unchecking it removes VZAccess Manager from the startup 
group.
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Updates tab
To access the Updates tab, click the Tools menu, then 
Preferences, and then click the Updates tab.

(Sample Illustration) Updates Tab

This feature allows VZAccess Manager to automatically 
check for software updates. If an update is available, you will 
be notified of its size and approximate download times if 
using the NationalAccess or BroadbandAccess connection.
If you select to download available updates, a display will 
show the progress as the update is downloading. You do not 
need to download the updates wirelessly; you can use any 
connection to the Internet. 

If you download the updates wirelessly, normal usage charges apply.

You can allow the software to automatically check for 
updates on a daily, weekly (default), or monthly basis. It only 
checks for updates when the application is running and you 
are connected and able to access the Internet. If desired, you 
can choose the Manually option and the software will only 
check for updates when you select Update Now, or when you 
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select Help from the VZAccess Manager's main screen, and 
then Check for Updates.

WWAN Preferences
To display WWAN preferences, click the Tools menu, and 
then select Preferences.

(Sample Illustration) WWAN Tab

The following options are available on the WWAN tab:
Connect options
Used to set various connect options as described below.
Automatically Connect: If desired, you can select to have 
VZAccess Manager automatically connect to Verizon 
Wireless NationalAccess - BroadbandAccess at startup.
Do not allow connectivity when roaming: Enabling this 
option will prevent you from connecting when roaming. 
Account options
Show non-wireless accounts in list: If you select this option, 
all of your dial-up accounts will display in the VZAccess 
Manager's list of accounts, allowing you to use VZAccess 
Manager to launch them instead of dial-up networking. 
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With this option unchecked, the only connections that are 
displayed in VZAccess Manager's list of accounts are 
Verizon Wireless connections and any other connections you 
have created. 
Do not prompt for user name and password: Since you are 
only using Verizon Wireless NationalAccess -
BroadbandAccess, this setting has no effect.
Security options
Security Setup: Used to lock/unlock the Toshiba 3G module 
and change the lock code.
Connect options
Clicking the Set Options button on the WWAN tab displays 
the Connect tab.

(Sample Illustration) Connect Tab

The following options are available on the Connect tab:
Do not open my browser: With this option selected, when 
you connect to a WWAN network, VZAccess Manager will 
not automatically launch your default web browser.
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Open my browser to my default home page: With this 
option selected, when you connect to a WWAN network, 
VZAccess Manager will automatically launch your default 
web browser and your home page will display.
Open my browser to this URL: With this option selected, 
when you connect to a WWAN network, VZAccess Manager 
will automatically launch your default web browser but 
display a specified URL instead of your home page.
Turn off graphics: If you select this option, it will turn off 
graphics in Internet Explorer.
With this option off, web pages will load faster but you will 
have to right-click and select Show Picture to display 
pictures. 
Run program on connection: This allows you to 
automatically run a program when you use VZAccess 
Manager to connect to a WWAN network. Use the Browse 
button to navigate to the desired application you want to run. 
The selected application will run for all WWAN connections 
made from VZAccess Manager.
VPN options
To display the VPN tab, click the VPN tab.

(Sample Illustration) VPN Tab
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The following options are available on the VPN tab:
VPN Client: VZAccess Manager automatically detects if 
certain VPN clients like Microsoft®, Cisco, CheckPoint and 
so on, are installed on the computer and allows you to select 
the one you want to use. Check with your network 
administrator to setup your VPN connection.
If the VPN client you wish to use does not appear in the list, 
you can select Other VPN Application. 
Other VPN Application: This allows you to automatically 
run any VPN program when you use VZAccess Manager to 
connect to a WWAN network. Enter the full path to the 
executable, or use the Browse button to select the desired 
VPN program.
Security setup
Available with some wireless devices, selecting the Security 
Setup button on the WWAN tab displays the following 
options:

(Sample Illustration) Security Setup Options

Lock code: Enter your 4-digit lock code (the default is the 
last 4 numbers of the Toshiba 3G module phone number) and 
select OK to lock or unlock the Toshiba 3G module.
Change Lock Code: Click this button to change the 4-digit 
lock code on the Toshiba 3G module and enter the following 
information:
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Current lock code: Enter your current 4-digit lock code.

New lock code: Enter your new 4-digit lock code.

Confirm new lock code: Re-type the new 4-digit lock 
code.

TXT Messaging Settings
To display TXT messaging options, click theTools menu, 
then Preferences, and then click the TXT tab.

(Sample Illustration) TXT Tab

The following options are available on the TXT tab:
Incoming message options
❖ Open TXT window on arrival of new message: 

VZAccess Manager will automatically switch to the TXT 
view when a new message arrives.

❖ Play sound on arrival of new messages: A sound file 
(.WAV) can be selected to play when new messages 
arrive.
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Outgoing message options
❖ Message delivery duration: The duration of time that 

the Verizon Wireless network will attempt to deliver the 
message. The default is one week.

Confirmations
The following confirmation dialogs can be turned on or off:
❖ Warn before deletion of messages
❖ Confirm deletion of messages
❖ Confirm sent messages.

Additional Features
In addition to the basic features described above, VZAccess 
Manager provides you with a number of additional features.

The Status Bar
Details for your current connection can be seen in the status 
bar at the bottom of VZAccess Manager.

(Sample Illustration) Status Bar

The status bar is always displayed when the interface is fully 
expanded. 
Connection status
The text on the top left portion of the status bar (above 
Verizon Wireless) reflects your current state. During an active 
connection, this text will read “Connected". If you are not 
connected, it will display "Not Connected".
Coverage
An icon will display if you are in NationalAccess coverage. 
Pass the mouse over the icon to see a tool tip showing the 
name of the current network.
New TXT
If you have signed up for TXT messaging, an icon appears on 
the status bar when you have a new TXT message waiting. 
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Double-click the icon to jump to TXT view to view the 
message.
Throughput
The amount of data that you have sent and received since the 
current network connection was started can be displayed by 
holding the mouse over the UP and DOWN arrows on the 
right side of the status bar.
Battery level
The current battery level of your PC is displayed on the right 
side of the status bar.
Elapsed time
The amount of time that has elapsed since the current 
network connection was started is tracked on the lower right 
side of the status bar.
Roaming status
VZAccess Manager displays roaming status. The following 
icons may be displayed on the status bar:

The Toolbar Buttons

(Sample Illustration) Toolbar Buttons

Networks 
Displays your available wireless connections and networks. 
Usage 
Provides a concise session log of your network activity. Click 
on a column heading to sort the log. This window also 
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displays the total number of sessions and the total time 
connected.
The information displayed in the Usage log can be 
customized as follows:

(Sample Illustration) Usage Log

❖ To view just the connection history of a specific network 
type, check the Selected connection checkbox and then 
select the desired type from the drop-down list. 

❖ To view just the connections made during a specific 
interval, check the Date range checkbox and specify the 
date in the “From” and “To” fields.

❖ To export the log as a CSV file, click the Export button. 
❖ To clear the log, click the Clear button. 

Clearing the log cannot be undone.

Apps 
Allows you to add applications that you want easy access to 
while connected to the wireless Internet. VZAccess Manager 
will preload links to Verizon Wireless web sites, and any 
Microsoft® Office application you have installed on your 
computer.
TXT 
Allows you to send short text messages to any other wireless 
device that supports SMS. This option is only available when 
you have signed up for TXT messaging.
Web 
Launches your default web browser.
Email 
Launches your default email application.
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Support 
Displays a variety of help options to find assistance with a 
problem, to explore the full range of VZW products and 
services, or to contact Verizon Wireless.

Minimizing the Application
To minimize VZAccess Manager, select Minimum from the 
View menu.
To return VZAccess Manager to its normal size, select 
Minimum from the View menu again.

The Tools Menu
The following options are available from the Tools menu:
Control Panels: From this menu, you have access to your 
systems Modem, Network and Dial-Up Connections, and 
Internet control panels. You can display all of the control 
panels by selecting All.
Dial-Up Accounts: Add, edit, or copy wireless dial-up 
accounts.
❖ Add Wireless: Used to create a new wireless dial-up 

connection.
❖ Add Other: Used to create a new regular dial-up 

connection.
❖ Edit: Used to edit properties of any dial-up connection.
❖ Copy: Used to copy connection information. Refer to 

Using Dial-Up Connections for details on copying 
connection information.

These options are only applicable if using a WWAN device that 
supports dial-up accounts.
You can also control modem dial-up connections from options 
available in the Preferences dialog.

The Options Menu
The following options are available from the Options menu:
Refresh Networks: VZAccess Manager verifies devices 
connected and scans for available networks. Use this feature 
if you connected your equipment after launching VZAccess 
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Manager. Pressing the F6 function key also executes this 
option.
Statistics: Displays a Statistics tab that will show data speeds 
during a session when using the WWAN device. 
NationalAccess delivers typical speeds of 60 to 80 kbps, 
bursting up to 144 kbps. BroadbandAccess provides 
broadband-like speeds (up to 1.54 Mbps).
There is also a My Computer tab that displays information 
about your computer that may be helpful when 
troubleshooting problems that may occur. 
Test WWAN Device: Retrieves and displays detailed 
information about your WWAN device such as manufacturer, 
model, version, and so on. 
Run Wizard: Runs the Setup Wizard, which is useful if you 
need to reconfigure VZAccess Manager.

The Help Menu
The following options are available from the Help menu:
Contents: Launches the online help. 
Check for Updates: Can be used with any connection to the 
Internet to check for VZAccess Manager software updates.

If downloading an update wirelessly, normal usage charges apply, 
refer to Update Options in Setting Your Preferences for more 
information.

Device Support Page: Displays the Verizon Wireless device 
support page that contains information about wireless 
devices, useful tips and hardware manuals.
Email Verizon Wireless Support: This option will attempt 
to launch your email client with the default address to  
Verizon Wireless Support.
About VZAccess Manager: Displays software version 
information, and your Toshiba 3G module’s ESN, phone 
number and signal level.

PMAD00336010.book  Page 25  Thursday, May 11, 2006  4:30 PM



26Settings in Other Applications

RG 5.375 x 8.375 ver 2.3.3

Settings in Other Applications
This section describes special settings that might be required 
in other applications.

Sync Applications
Palm Incorporated's HotSync® and Microsoft® Corporation's 
ActiveSync® are used for Personal Digital Assistants 
(PDAs).
These programs are used to synchronize files between a 
notebook or desktop PC and the PDA. These programs may 
conflict with your WWAN device. If you have any problems 
using your WWAN device, try turning these programs off as 
described below:
To turn HotSync on and off
Right-click on the HotSync® icon in your task tray and click 
Local Serial and then Local USB (the checkmarks should be 
removed). This disables HotSync® and if it is causing a 
conflict, it will allow your WWAN device to work properly. 
You can repeat the process to re-enable HotSync®. If you are 
using an early version of HotSync®, you may not be able to 
disable the Local options without first selecting Modem or 
Network. In this case, you can always choose Exit to close 
HotSync® and launch it from the Start menu the next time 
you need it.
To turn Windows® CE services on and off
For the original Windows® CE services: 
❖ Right-click on the Windows® CE Services icon in your 

task tray and select/deselect Enable Serial Connection. 
Make sure it is unchecked when running Mobile Office 
and checked when you want to sync your Microsoft® 
Windows® CE based PDA.

For Microsoft® ActiveSync®: 
❖ Right-click on the ActiveSync® icon in your task tray and 

select Connection Settings.
❖ Select/deselect Allow serial cable or infrared 

connection to this COM port: and Allow USB 
connection with this desktop computer. Make sure they 
are unchecked if you are having trouble connecting with 
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your WWAN device and restore them to their original 
settings when syncing your PDA. 

❖ Click OK when finished.

Proxy Settings
Proxy settings effect the way your computer and 
browser connect to other computers on the Internet and 
local networks. It is highly recommended that you 
consult your network support staff before changing 
these settings described here.
Most corporations go through a proxy server to access the 
Internet via the corporate network. If you wish to access the 
Internet directly through BroadbandAccess or 
NationalAccess, proxy settings must be turned off. 
If you are connecting to your corporation's network using 
VPN (Virtual Private Networking) and your corporation uses 
proxies, then you need the correct proxy settings in order to 
access the Internet. For exact details on the required proxy 
settings, contact your corporate network technical support.

When directly accessing the Internet, performance is improved 
because you eliminate VPN client overhead. 

Proxy settings if using Internet Explorer 
(version 5 and newer)
If you are using proxy settings when connected to a corporate 
network via your network adapter, they will be entered under 
LAN settings. These settings apply to devices that appear to 
Windows® as a network adapter. You can access the LAN 
settings as follows:
1 In Internet Explorer, select the Tools menu, and then 

Internet Options.
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(Sample Illustration) Internet Options Dialog

2 Click the Connections tab and then click the LAN 
Settings button.
If your company uses proxy settings they will be 
displayed on the LAN Settings dialog.

(Sample Illustration) LAN Settings Dialog
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If using a WWAN device, the NationalAccess - 
BroadbandAccess connection from within VZAccess 
Manager will have no proxy settings associated with it by 
default. This means you can access the Internet directly 
using the connection as long as you are not connecting 
via VPN and your company requires proxy settings. 

3 If you need to enter proxy settings for the NationalAccess 
- BroadbandAccess connection that is used by VZAccess 
Manager, select the connection from the Connections tab 
and then select Settings. 
The exact name of the connection used by VZAccess 
Manager is "NationalAccess – BroadbandAccess”.

4 Enter the same proxy settings you recorded in Step 2, if 
you need to use VPN and proxy settings with this 
connection. If necessary, also enter the information 
collected on the Advanced screen by clicking the 
Advanced button. 
To disable proxy settings for this connection, uncheck the 
Use proxy server checkbox. Proxy settings must be 
disabled to access the Internet directly when using a 
connection without VPN.

Proxy Settings if using Internet Explorer 4.x
In Internet Explorer 4.x, proxy settings are global and have to 
be turned off when directly accessing the Internet through the 
Verizon Wireless BroadbandAccess or NationalAccess 
connection, and then back on if required by your company 
when using their network to access the Internet or when using 
VPN.
1 Right-click on the Internet Explorer icon and choose 

Properties.
2 Click the Connection tab. 
3 Uncheck the Access the Internet using a proxy server 

checkbox, and then click OK or Apply. 
You may now directly access the Internet through the 
Verizon Wireless NationalAccess connection.
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When you want to access the Internet through your corporate 
network proxy server, you must repeat these steps, by selecting 
Access the Internet using a proxy server, and then clicking OK. If 
your proxy settings are incorrect for the connection you are using, 
you will receive an error whenever you try to go to any site.

Proxy Settings if using Netscape® Navigator 4.0 and higher
For Netscape® Navigator 4.0 and higher, proxy settings are 
global and have to be turned off when directly accessing the 
Internet through the Verizon Wireless NationalAccess 
connection, and then back on if required by your company 
when using their network or when using VPN.
1 From within your browser, choose Edit, and then 

Preferences.

2 Click on the "+" next to Advanced and then choose 
Proxies. 

3 Select Direct connection to the Internet and then click 
OK.
You may now directly access the Internet through the 
Verizon Wireless NationalAccess connection.

When you want to access the Internet through your corporate 
network proxy server, you must repeat these steps by selecting 
Manual proxy configuration then clicking OK. If your proxy settings 
are incorrect for the connection you are using, you receive an error 
whenever you try to go to any site.

Instructions for AOL Users
AOL supports using other connections to the Internet, so it 
can be used with the Verizon Wireless NationalAccess 
connection.

If you installed AOL after installing the Verizon Wireless Mobile 
Office software or if you upgraded to a new version of AOL and are 
having trouble accessing web pages, refer to the Troubleshooting 
section.
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Configuring AOL version 9
1 Right-click on the AOL icon in your task tray, and then 

click Auto Start Options.
2 Select Don't use any Auto Start options, and then click 

OK. 

(Sample Illustration) AOL Settings

3 The first time you run AOL after setting your wireless 
device up as a modem, you may see the following 
message.

(Sample Illustration) Improving Your Connection Message

4 Click OK to proceed. 
AOL will attempt to detect how it might be able to 
connect.

5 Once AOL detects a connection, select Cancel.
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6 From the sign on screen, click Sign On Options.
7 Click Expert Setup and then Add Location.
8 Enter Verizon Wireless in the Location Name text box, 

and then click Next.
9 If Other Dial-up ISP or LAN is available, select it, and 

then click Next. If this option is not available, select 
Manually add a connection device, click Next, select 
Other Dial-up ISP or LAN, and then click Next.

10 Click Next until the Summary screen displays.

(Sample Illustration) Summary Screen

11 Click on Sign On to AOL Now to save the settings. 
Since you are not actually connected to the Internet, AOL 
will not be able to sign on, but it will save your changes.

12 Select Close when the following message displays.
This completes configuring AOL to work with any 
connection to the Internet, including BroadbandAccess, 
NationalAccess and Quick 2 Net (14.4 kbps).

Using AOL version 9 with your Mobile Office connections
To use AOL with the Verizon Wireless NationalAccess 
connection:
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1 Select the connection from VZAccess Manager's main 
window and click Connect.

2 Once connected, launch AOL. 
3 From your sign on screen, select Verizon Wireless for 

the location and sign on. 

You can set VZAccess Manager to automatically launch AOL when 
you connect. To do so, on the WWAN Specific Settings window, 
check the box to Run program on connection:, then using the  
Browse button, locate and select aol.exe (normally, it is located on 
your "C" drive in an America On Line folder, under the Program Files 
folder).
If you normally use a landline modem rather than a wireless connec-
tion, just remember to change the location back to your landline 
number when not using the Verizon Wireless NationalAccess con-
nection.
To disconnect the Verizon Wireless NationalAccess connection, click 
on the Disconnect button in VZAccess Manager. (Signing off AOL 
will not end the call.)

Using Email with VZAccess
POP3 email
You can use the Verizon Wireless NationalAccess connection 
to access your POP3 email account if your email provider 
allows access through other providers. If your provider 
restricts access to their outgoing mail server, you will get an 
error message when attempting to send mail.
Most send mail servers are not accessible from outside 
connections to the Internet. You usually have to be connected 
to the email providers network to access their mail server, and 
most email providers require authentication (a user name and 
password). Without these security measures, anyone can use 
a send mail server to send massive amounts of unwanted junk 
email. If you are having trouble sending email, which 
includes replying to email and forwarding email, and you are 
getting an error message, then your send mail server can not 
be accessed from the Verizon Wireless network.
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For customers in this situation, Verizon Wireless has made 
available a send mail server that you can use in place of the 
one you normally use. All that is required is that you have a 
TXT messaging capable Verizon wireless phone or device 
and TXT messaging service, visit www.vtext.com and 
establish a profile by selecting Join Up.
After entering your 10 digit mobile number, a TXT message 
will be sent to your handset or device to establish your 
password. Most Verizon Wireless phones are TXT message 
capable. 
To use the Verizon Wireless Send Mail Server, you need to 
edit your existing mail account settings and change the 
outgoing mail server. 
❖ In place of your existing Send Mail Server, enter 

smtp.vzwmail.net.
❖ Select My server requires authentication, and then 

enter the 10 digit mobile number@vzwmail.net (for 
example, 6145551212@vzwmail.net) as the Send Mail 
Server user name. 

❖ Enter the password you created at www.vtext.com. You 
will also be able to use this server when connected to the 
Internet from other providers eliminating the need to 
change the setting when you switch from being 
connected to the Internet through Verizon Wireless. If 
you need to know where these settings are normally 
entered in your email client, check with your email 
provider. For your convenience, settings for Outlook 
Express® are as follows:

1 Select Tools, and then click Accounts.
2 Select your default account, then then click Properties.
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(Sample Illustration) Account Properties Screen

3 Click the Servers tab. 
4 In the Outgoing mail (SMTP) field, enter 

smtp.vzwmail.net. 
5 In the Outgoing Mail Server section at the bottom of the 

screen, select My server requires authentication, and 
then click Settings.

(Sample Illustration) Outgoing Mail Server
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6 Select Log on using, and then enter the 10-digit mobile 
number@vzwmail.net for the account name (for 
example, 6145551212@vzwmail.net).

7 Enter the password you created on www.vtext.com. 
8 Select Remember password. 
9 Click OK, then Apply, and then OK. 
10 Click Close to return to the Outlook Express® main 

screen. 
It may take up to two hours for your www.vtext.com 
credentials to be valid on the smtp.vzwmail.net server. 
Once validated, you should be able to send mail using the 
Verizon Wireless Send Mail Server (also referred to as a 
SMTP - Simple Mail Transport Protocol Server), when 
you are connected to the Internet, wirelessly or via other 
means.

Additional notes about the Verizon Wireless Send Mail Server
❖ There is no monthly charge for this service.
❖ Message limits: 2MB message size, 100 recipients per 

message.
❖ Customers that are identified as using this server to 

generate SPAM messages will be denied access to the 
server (email messages will not be sent).

❖ If you are using an email client other than Outlook® or 
Outlook Express® and it fails to work with the Verizon 
Wireless Send Mail server, it may not correctly support 
authentication. Try using Outlook Express® if you have 
problems. If it works, and your email client does not, 
check to see if any updates are available for your email 
client.

Credentials established on www.vtext.com may take up two hours 
before they will work on the smtp.vzwmail.net server. If your 
credentials work on www.vtext.com but not on the smtp.vzwmail.net 
server, try again after two hours.

Web-based email
If you currently do not have email software, you can sign up 
for web based email at any of the popular portal sites, such as 
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http://www.yahoo.com, or http://www.msn.com. You may 
also search for other email providers from any of these pages.

Troubleshooting
When installing VZAccess Manager, it did not find the WWAN 
device 
For a 1xEV-DO/1XRTT/CDMA device:
❖ Make sure that the wireless communication switch is in 

the ON position.
❖ Identify any software that uses the serial port on your 

notebook computer or other USB devices (such as 
Microsoft® Windows® CE services, ActiveSync® and 
Palm HotSync®) and exit all of these programs.  Refer to 
Turning Sync Applications On and Off for more 
information.

❖ Make sure that the auto-answer feature of any fax 
software you are using is disabled.

If this is the case, you will only be able to access the Internet 
when using VPN. To directly access the Internet, you will 
have to disable the Winsock Proxy. Usually these 
applications have an icon in the Control Panel that allows you 
to turn them on and off. Check with your Network 
Administrator.

I get connected, but I can't get to any web sites
❖ If you are using VPN (Virtual Private Networking) you 

may require proxy settings on the NationalAccess 
connection. Disconnect from your VPN and see if you 
can access the Internet directly. For additional 
information refer to Turning Proxy Settings On and Off.

❖ If you are using a PC provided by your employer, it's 
possible they are using Microsoft's Winsock Proxy or a 
similar program that enforces proxy settings without 
having to enter any settings into your web browser.
If this is the case, you will only be able to access the 
Internet when using VPN. To directly access the Internet, 
you will have to disable the Winsock Proxy. Usually the 
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application have an icon in the Control Panel that allows 
you to turn them on and off. Check with your Network 
Administrator.

I can receive email, but cannot send email using my email 
program
Some Internet Service Providers (ISP) require that you be 
connected through them in order to access their mail server to 
send email. Refer to Email Options for more information.
Every time I try to establish a NationalAccess - 
BroadbandAccess connection, it fails
❖ Most likely, you are outside of NationalAccess and 

BroadbandAccess coverage.
Wireless Communications

Important notice
Due to the transmission and reception properties of wireless 
communications, data can occasionally be lost or delayed.
This can be due to the variation in radio signal strength that 
results from changes in the characteristics of the radio 
transmission path. Although data loss is rare, the environment 
where you operate the modem may adversely affect 
communications.
Variations in radio signal strength are referred to as fading. 
Fading is caused by several different factors including signal 
reflection, the ionosphere, and interference from other radio 
channels.
Toshiba will not be held responsible for damages of any kind 
resulting from the delays or errors in data transmitted or 
received with the wireless WAN, or failure of the wireless 
WAN to transmit or receive such data.
RF Exposure/Specific Absorption Rate (SAR) Information 
This product has been evaluated for SAR and meets the FCC 
Guidelines for exposure to radio waves.
Your wireless modem is a radio transmitter and receiver. It is 
designed and manufactured not to exceed the exposure limits 
for radio frequency (RF) energy set by the Federal 
Communications Commission (FCC) of the U.S. 
Government.
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These limits are part of comprehensive guidelines and 
establish permitted levels of RF energy for the general 
population.
The guidelines are based on standards that were developed by 
independent scientific organizations through periodic and 
thorough evaluation of scientific studies. The standards 
include a substantial safety margin designed to assure the 
safety of all persons, regardless of age and health.
The exposure standard for wireless devices including mobile 
phones and wireless modems uses a unit of measurement 
known as the Specific Absorption Rate, or SAR. Tests for 
SAR are conducted using standard operating positions 
reviewed by the FCC with the device under test transmitting 
at its highest certified power level in all frequency bands. 
Although the SAR is determined at the highest certified 
power level, the actual SAR level of the phone or modem 
while operating can be well below the maximum value. This 
is because the phone or modem is designed to operate at 
multiple power levels so as to use only the power required to 
reach the network. In general, the closer you are to a wireless 
base station antenna, the lower the power output.

Glossary
1xRTT
Short for single carrier (1x) Radio Transmission Technology. 
A high speed wireless technology based on the CDMA 
platform. 1xRTT has the capability of providing broadband-
like speeds of up to 144 Kbps. 1xRTT is also referred to as 
CDMA2000.
1xEVDO
Part of a family of CDMA2000 1x digital wireless standards. 
1xEVDO is a "3G" standard. EVDO stands for "EVolution, 
Data-Only". 1xEVDO is based on a technology initially 
known as "HDR" (High Data Rate) or "HRPD" (High Rate 
Packet Data), developed by Qualcomm. The international 
standard is known as IS-856. 1xEVDO has the capability of 
providing broadband-like speeds of average speeds of 300-
600 kbps.
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bps
Bits per second – rate of data flow.
Broadband
High-capacity high-speed, transmission channel with a wider 
bandwidth than conventional copper telephone lines.
Broadband channels can carry video, voice, and data 
simultaneously.
COM Port
Defines a serial/RS-232 port within the Windows® 
environment. May be physical or virtual.
Dial-Up Connection
A switched network connection established by a computer 
using an analog data modem over ordinary copper telephone 
lines.
Dormancy
A network state that occurs when no data has been 
transmitted or received after a given amount of time. A 
network connection may disconnect during a dormant state.
Firewall
A hardware or software boundary that protects a network or 
single PC from unwanted outside traffic.
HTTP
Hyper Text Transfer Protocol
ISP
Internet Service Provider
IP
Internet Protocol. The mechanism by which packets are 
routed between computers on a network.
Kbps
Kilobits per second – rate of data flow
LSP
Layered Service Provider – a Microsoft® feature
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LAN
Local Area Network. A data network confined to limited area 
with moderate to high data rates. Does not use common 
carrier circuits, although may have gateways or bridges to 
other public or private networks.
Mbps
Megabits per second
PC
Personal Computer
PCMCIA
Personal Computer Memory Card International Association. 
PDA
Personal Digital Assistant. A handheld device used for 
organization, notes, address books, and so on.
POP3
Post Office Protocol v3. A standard transport protocol used 
send and receive email.
Proxy
A firewall mechanism that replaces the IP address of a host 
on the internal (protected) network with its own IP address 
for all traffic passing through it.
Serial Connection
A network connection established by a serial device such as a 
modem. Serial communication between your PC and modem 
or other serial devices adhere to the RS-232 standard.
SMS
Short Messaging Service. Short text messages of generally no 
more than 140-160 characters sent and received by wireless 
devices.
Sync
To compare and synchronize two or more sources of data.
TCP/IP
Transmission Control Protocol / Internet Protocol
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URL
Uniform Resource Locator
USB
Universal Serial Bus. A connection type for computer 
peripherals such as a printer, mobile phone, and so on.
VPN
Virtual Private Network. A way to communicate through a 
dedicated server securely to a corporate network over the 
Internet.
WAN
Wide Area Network. A network which uses common carrier-
provided lines. 
WEP
Wired Equivalent Privacy. A security protocol for wireless 
local area networks (WLANs) defined in the 802.11b 
standard. WEP is designed to provide the same level of 
security as that of a wired LAN.
WWAN
Wireless Wide Area Network
WWW
World Wide Web
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